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Introduction
Hi, I’m Gregg Hillmar. I’ve been working for many years as a scenic 
and lighting designer for theatre and other entertainment industries. In 
addition to a vigorous freelance career, I have taught at a variety of 
graduate and undergraduate institutions before happily settling at 
Randolph-Macon College in Ashland, Virginia. I’ve been using the 
Nemetschek Vectorworks software package, and before that MiniCAD, 
since about 1992, and “full-time” since 1994 or so—based on the last 
hand-drafted show in my portfolio. I first experimented with drawing 

light plots and scenery in MacPaint, having bought my first Macintosh computer in late 1984. 
Subsequently I tried MacDraft, Canvas, and Generic CADD among others, but it was not until 
discovering MiniCAD that I felt giving up the pencil was in order.

Fast-forward several years, and I’m now asked to demonstrate Vectorworks software,  
and particularly Vectorworks Spotlight at the Nemetschek Vectorworks booth at industry 
conventions including LDI, USITT, and SETC. I have also worked as a Vectorworks trainer 
and consultant for private corporations and public training seminars sponsored by theatrical 
organizations and educational institutions. I’ve done several Spotlight training sessions for  
the Nemetschek Vectorworks’ sales and tech support teams, including taking them into 
theatres to witness firsthand the spaces, materials, and tools of our industry.

This book will take a quick look at how I use Vectorworks software to draft lighting plots.  
My way is not the only way. It’s not right or wrong. It’s just the way my practice and  
workflow have evolved over the 15 years I have been using Vectorworks. I’m reminded of 
Stanley McCandless’ famous (at least to lighting designers) book A Method of Lighting the 
Stage, which to many designers turned into the method of lighting the stage. There is no “the” 
implied here. My approach is not the end-all and be-all, but it works for me. This book reflects 
my approach, so feel free to adapt my ideas to your own style.

My point of view is that theatrical drafting is about communication. It is somewhat free of the 
structures used in strictly architectural practice, but the end results are the same. We need to 
communicate clearly and concisely with those we work with. They need to be able to under-
stand in an instant what they are looking at and be able to use that information. Choices we 
make in line weight, dashes, hatches, symbols, and all of the other graphics are the language 
in which we communicate. Page layout and choices of what is on each plate in a set of 
drawings puts that language into context. The composition of the page refines that context. 
We can turn out really beautiful drawings, full of style and grace, but unless the shop can read 
them and instantly understand the intended communication, the drawings are just so much 
paper waiting to be recycled. 
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This book will certainly reflect my drafting style as taught to me primarily by William H. Lockey 
(University of Richmond), and John Rothgeb and David Nancarrow (University of Texas, 
Austin). My style has been further refined by many years of drafting scenery and lighting  
for the theatre, and working with myriad theatre artists who also draft. From them, I’ve 
borrowed what I like, and vowed to never do what I don’t like. Note that this is not a book 
about drafting style. There are better books out there for that; some are CAD-specific, but  
the ones I like are not.

It is also worth noting that the output this book is geared toward is a 2D plot and paperwork. 
While we will delve into the 3D world of the Vectorworks program as it assists us in creating 
the plot, that plot, printed, is our final goal. And a plot, printed, is a 2D representation. 3D 
computer modeling, and lighting models, is perhaps the subject of another book.

Finally, there is not any discussion of DESIGN choices here; you’re on your own for those.  
We need to remember that the output that this book is geared toward (the plot) is NOT art,  
but communication. Art happens in the theatre. Perhaps that is best described, even all these 
years later, by Robert Edmond Jones in “Light and Shadow in the Theatre,” in Chapter 6 of 
The Dramatic Imagination (1941):

We handle our spotlights and gelatines and dimmers [...and CAD software...] in the 
theatre with the same delight and the same sense of mastery with which we drive a 
high-powered automobile or pilot an aeroplane. But at rare moments, in the long quiet 
hours of light-rehearsals, a strange thing happens. We are overcome by a realization 
of the livingness of light. As we gradually bring a scene out of the shadows, sending 
long rays slanting across a column, touching an outline with color, animating the scene 
moment by moment until it seems to breathe, our work becomes an incantation. We 
feel the presence of elemental energies (Jones, p. 113).

While we are studying to perfect ourselves in the use of the intricate mechanism of 
stage lighting we are learning to transcend it. Slowly, slowly, we begin to see lighting in 
the theatre, not only as an exciting craft but as an art, at once visionary and exact, 
subtle, powerful, infinitely difficult to learn. We begin to see that a drama is not an 
engine, running at full speed from the overture to the final curtain, but a living organ-
ism. And we see light as a part of that livingness (Jones, p. 114).

And, “Lucidity, penetration, awareness, discovery, inwardness, wonder…. These are the 
qualities we should try to achieve in our lighting” (Jones, p. 121).

And perhaps best, “Does this mean that we are to carry images of poetry and vision and high 
passion in our minds while we are shouting out orders to electricians on ladders in light-
rehearsals? Yes. This is what it means.” (Jones, p. 128).

Vectorworks
Vectorworks software has had a long and storied life. First introduced in 1985 by Diehl 
Graphsoft, the program was originally created by Richard Diehl who, as legend has it, wrote 
code while sitting at his kitchen table. Initially a Macintosh-only application, the program 
became cross-platform in 1996. Its evolution continued, and the software was renamed 
"Vectorworks" in 1999. With the 2000 merger of Diehl Graphsoft, Inc. and Nemetschek AG of 
Munich, Germany, into Nemetschek Vectorworks, Inc., the company became Nemetschek 
AG's largest U.S. subsidiary.

In 2001, Nemetschek Vectorworks introduced several separate industry specific products. The 
software is now available as: Vectorworks Fundamentals for basic design, Architect for 
building design, Landmark for landscape design, and Spotlight for entertainment design. The 
Vectorworks Designer product includes the features and functionality of all of the industry-
specific programs combined into one package, and the Renderworks application, featuring the 
CINEMA 4D render engine, can be added to each to produce high-quality presentations.

Early in its history, Diehl Graphsoft identified theatrical design as a viable market and is the 
only major publisher of CAD software that I am aware of who intentionally hired developers 
with theatre backgrounds to support theatrical applications of that software. In the mid-1990s, 
Diehl Graphsoft hired Frank Brault to develop some theatre-specific macros and symbols. 
Brault came from a professional theatre and dance background with lighting experience. The 
Lighting Toolkit package grew out of his initial work. Sometime thereafter, Kevin Moore and 
Kevin Linzey were hired, first as student interns and then full-time. Kevin Moore took over 
Spotlight development. Both Kevins had theatre backgrounds, and both have worked for me 
on various shows and events. Kevin Moore eventually left Nemetschek to return to event, 
production, and management work, and Kevin Linzey moved into the lead Spotlight developer 
role. Kevin Linzey does still occasionally work in theatres while keeping his “day job” with 
Nemetschek Vectorworks. The people working on and with Spotlight know theatre as well as 
software development. The ongoing commitment to theatre on the corporate level and the 
individual level is a huge advantage for all of us. 

As noted earlier, MiniCAD was developed initially for the Macintosh. More than a decade after 
the first PC release, though, Vectorworks remains a cross-platform program. It works equally 
well on a PC as it does on a comparable Macintosh. There are no real programming differ-
ences. Files created on one can be opened and used on the other and traded back and forth 
with no issues. There are some minor differences, mainly visual, created by how the two 
operating systems work. As an example, in the PC world, palettes can be floating or “docked” 
into the program’s window. On the Macintosh, the drawing window and all the palettes are 
always separate floating windows. I should mention that all screenshots used here are from 
the Macintosh version.
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What’s New
The first edition of Light Plot Deconstructed came out during the Vectorworks 2009 “model 
year.” I stated then that the concepts and general usage of the book were not specific to  
one version of Vectorworks. I would still say that with some modification for changes in 
workspaces and tools, this book should work fine with many versions of Vectorworks. This 
book is more about approach and is not a step-by-step tutorial.

That said, I have upgraded this edition to reflect software updates in Vectorworks 2012. 

Vectorworks Spotlight has seen some improvements. Vectorworks 2010 and 2011 introduced 
some new tools, including some very nice video projection tools and soft goods tools initially 
developed by C. Andrew Dunning of Landru Design. Vectorworks 2012 has added some new 
workability and options to these tools. Improvements in event planning and staging tools will 
have obvious implications for those designing conventions or other events. 

Some additional changes in Vectorworks Spotlight 2012 make drawing the plot easier. 
Mirroring positions and instrumentation has received some improvements. For example, when 
working on a dance plot I would often draw all of the booms on stage left and then wish to 
mirror the booms and instruments to stage right. This now works far better than in earlier 
versions. Multi-circuit lights (strip lights or other multi-cell cyc lights) also received some 
attention, as did the automatic data exchange between Vectorworks Spotlight and Lightwright 5. 

Focus points can now be created on the fly: Simply select a lighting instrument and choose 
where that instrument focuses. Other improvements enhance 3D functionality; more 3D 
lighting fixtures now rotate to point to the assigned focus point while the 2D representation 
stays as set by the user.

A major change in the Vectorworks software in the last several years is the continuing 
evolution of the 3D model as the basis for all views and details. This presents an interesting 
dichotomy in that the desired output in this book is a 2D drawing— the plot, printed.

A light plot is a particular 2D view of a 3D space. It is not a simple top view, and it uses 
symbols, not real objects, to represent items in the view. The thing to be aware of is that 
Vectorworks has been moving away from purely 2D drafting into a 3D world, which can 
include traditional 2D elements.

The simplest way to explain this is that 2D geometry and information can now interact with 3D 
space. In earlier versions of Vectorworks, I could draw a rectangle using the 2D Rectangle 
tool. I could then change to any 3D view—front, front-left isometric, rear, whatever, and the 
rectangle “hovered” in front of the view, parallel—if you will—to the screen. 

In Vectorworks now, I can define different ways to deal with those 2D objects. 2D objects can 
be either in the “screen plane” in that they will always be “parallel” to the screen regardless of 
the view “behind” them, or they can be in the “layer plane,” which means that they are 3D 
objects in a plane, by default the X,Y plane with no Z presence at all. Layer Plane objects thus 
defined display in 3D views as if they were laying “on the floor.” This is very handy for seeing 
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2D floorplans while in 3D views. With the 2D floorplan in a Left Isometric view in Figure 1. 2D, 
objects drawn in the Top/Plan view will default to Layer Plane, while 2D objects drawn in any 
other standard view will default to Screen Plane. 

If a Working Plane is defined, Layer Plane objects can be drawn on that plane, meaning that 
"2D" details can be drawn over 3D objects and will keep their relationship to that object in any 
3D view. This is great for elevations and detail drawings.

One of the exciting things about Vectorworks 2012 is that Working Planes can now be 
automatically set parallel to sides of 3D objects, making the relationship between 2D and 3D 
objects faster and easier. With a Working Plane automatically set to the side of a 3D object, I 
can now draw right on that face.

Layer plane objects can also be “pulled” or “pushed” after creation to turn them into true 3D 
objects. Working with the Automatic Working Planes makes building the 3D model very 
intuitive.

One thing to be aware of is that layer plane and screen plane objects are NOT the same. 
I’ve found that using some of the 2D commands, such as “add surface” or “clip surface,” will 
fail if the objects are of different types. Layer Plane objects should be thought of as 3D objects 
with no Z height. They can interact with other Layer Plane objects but not with Screen Plane 
objects.

It is important to note that even though the plot, printed, is a bastardized 2D drawing, lighting 
designers in general make much use of the 3D world in the creation of the lighting design. 
Knowing angles, distances, and how the light interacts with space is crucially important. 
Likewise, improvements in Attribute Mapping may not seem terribly important to lighting 

designers. If, however, I am visualizing and rendering scenery under my light plot, the ability to 
easily manipulate the textures that a scenic designer may have used greatly improves my 
workflow. 

Text and dimensions have both seen further improvements, making the way they interact with 
the 3D world much better. 

When using Vectorworks Designer or Architect products, walls interact with a new element in 
the data structure: “stories.” Layers can now be assigned to a story, and their Z height will be 
relative to the story height. A wall could be on a layer related to the second story. If the story is 
defined as 12’ above 0, the wall would start 12’ in the air. If the wall was defined as going from 
floor to ceiling, and the third story was defined as 20’ above 0, the wall would draw itself 8’ tall. 
While layers used to have similar functionality with the delta Z, stories should carry this further. 
In the theatre, I won’t use this much at all, so I will still define wall heights and other param-
eters in the Object Information palette as before.

Rendering has been much improved in Vectorworks 2012. While seemingly not of much 
advantage when drawing a light plot, improvements are seen when panning or zooming. 
Instead of losing parts of the plot until a redraw occurs, I can now see all of my drawing while 
panning or zooming, allowing better accuracy as I navigate the drawing. This speed increase 
becomes really evident in viewports and referenced drawings.

Since almost everything referenced in this book deals with the plot as a 2D document, and 
most tools are used in Top/Plan view (the “2D” view) when creating the plot, many of these 
changes are not immediately noticeable. However, the way lighting designers use the 3D 
aspects available in Vectorworks has changed as the ease of working in 3D improves. Scenic 
designers, of course, have much more use for many of the 3D aspects. As we receive files 
from them, we’ll be able to put some of the 3D technology to use.

Visit the Nemetschek website for a complete overview of the changes in Vectorworks 2012 
and earlier versions.

In this book, illustrations, menu commands, and tool references have been updated as 
needed to reflect Vectorworks 2012. Most of the tools and techniques I use are available in 
Spotlight and Renderworks added to Fundamentals, though my copy of the software is a full 
Designer version. I also use several third-party scripts and macros, which are listed at the 
back of this book. However, most techniques I discuss will be available to all Vectorworks 
Spotlight users with Renderworks.

Figure 1
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In Ye Olde Days…
In “Ye Olde Days,” using a drafting machine, a parallel, or a T-square, we carefully squared a 
piece of vellum onto our drafting boards and taped it into place. We then grabbed our lead 
holder or mechanical drafting pencil, and began drafting…

Ah, but what and where? 

While designing scenery, most often I’d start by squaring a bluelined print of the theatre 
floorplan to the drafting board and then lay a piece of vellum or, if still thinking, a piece of 
butterpaper over that. Butterpaper was much cheaper than vellum and so easily thrown away. 
Based on quick thumbnail sketches, rough sketchy workings of the floorplan would emerge. 
Tape down another piece of butterpaper, copy up the good stuff, and keep thinking on paper. 
Then, slap the vellum on top of the stack on the drafting board, and trace up the architecture 
and the rough set. Add the titleblock, and it’s done.

Not quite. The floorplan is pulled off the board, another piece of vellum squared down, and 
elevations are started. Hmmm. Does that door look better if it is off center in the wall? Does 
that reflect the character of the inhabitants better? Sure, let’s change it! So we finish roughing 
in the elevations on that one page. Pull it up, and lay the floorplan back on the drafting board. 
Pull out the electric eraser, and move the door on the floorplan. Pull up the floorplan, lay down 
another sheet, and work those elevations. Hmmm. What can the audience see through that 
window? What can audience members in the balcony see? Pull up the elevation, lay down a 
blueline of the center line section of the theatre and a piece of vellum, and rough in a section 
of the set. If we move that wall 6" further downstage, the masking can work with the existing 
linesets. Finish roughing it in, pull the section off the board, put the floorplan back down, dig 
out the eraser, and move the wall on the floorplan. Pull that up, tape the elevation back down, 
and…

Well, only sometimes was the process quite so convoluted, but that was the thought process.

And deciding what each plate looked like was important. Plates of drafting are methods of 
communication, and composition of the plates was important in that communication. Leading 
the eye to the important information is part of the job of the composition. Which elevations 
would fit on which plate with which other elevation? Or with which detail? And where on the 
plate was best? Balance the tendency to read from top left with the reality of not flipping a 
whole set of drawings, stapled, all the way open. Top right becomes the first seen, though the 
placement of the titleblock may influence that. So, just like in any “artistic” composition, I use 
other elements to control emphasis and visual flow. Decisions about what would be on each 
plate needed to be made at the beginning of the process, and any changes in those decisions 
meant tedious redrafting of the entire plate(s). 

Drawing a light plot was a little less complicated. I usually started with the floorplan of the set 
and the architecture of the theatre. In a multi-set show, the floorplans might be on different 
sheets, so again I would have multiple layers of vellum on the drafting board. The section 
drawing and a composite front elevation of the set were developed and kept close at hand to 
check the angles at which light was hitting the performer.
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Lay down a fresh sheet of vellum, and draw indications of the areas to be lit. Using a drafting 
machine, squares are faster to draw than circles or ovals, so I marked my areas as squares. 
Of course, I know that light doesn’t naturally fall into nice neat squares, nor do I usually want it 
to, but it is a convenient visual representation. Next I might draw the existing lighting positions 
and then add a fresh sheet of vellum and start drawing instrumentation. Use the drafting 
machine to mark the horizontal angle from the area to the position, check the section to make 
sure the vertical angle works. Mathematically calculate the distance of the throw. Check the 
size of the beam for the preferred instrument type at that throw, then get out the lighting 
template and draw the outline of the desired instrument. Add notes about color, channel, 
purpose, and so on. Move to the next area. Wash. Rinse. Repeat. But wait! In order to get the 
right angles, these two instruments must hang in the same place. One has to move. And in 
order to keep instruments 18" apart—a long-standing industry “standard”—that means four 
other instruments next to this one need to move also. Dig out the electric eraser, erase, and 
redraw. Wash. Rinse. Repeat.

Once the rough plot is finished, I’d lay down yet another sheet of vellum and trace up all of the 
information that I wanted to appear on the plot. One of the major ways I control composition 
and visual importance in drafting is through use of line weight. Line weight is achieved 
primarily through the darkness and the thickness of a line. In Ye Olde Days, this was achieved 
in several ways.

Graphite lead was used in “lead holders.” Lead came in different hardnesses. Softer leads put 
more graphite on the page and were generally considered “darker” or “heavier” than harder 
leads. Harder leads were more suited to thinner lines, while softer leads worked better for 
thicker lines.

The sharpness of the lead created different line thicknesses. The lead was “twirled” in a lead 
sharpener to a razor sharp point, or a slightly blunted end. The resulting lead dust was 
removed by sticking the now-sharp lead into a “swab” of cotton, or of Styrofoam, or—my 
personal favorite—the end of a roll of toilet paper. The sequence of drawing a few lines, 
sharpening, and dusting created its own rhythm and Zen-like concentration. Sharpening stops 
were perfect times to contemplate the look of the object being drawn and make decisions 
about the next few lines.

Control of the lead holder was also critical. The lead had to be perpendicular to the page at all 
times or the point would be “wedged,” and the resulting line would not be a consistent width. 
Drafting involved a subtle twist of the lead holder as lines were drawn to even the wear on the 
point.

I had one professor tell me that another part of the line weight equation was the indention the 
pencil made in the paper. So control of the depth of the line was another method of line weight 
control when bluelining was the method of distribution. It took careful control to push the lead 
deep enough into the vellum to make a good trough, but not so deep as to rip through the 
vellum. 

Mechanical drafting pencils were also available. Similar to mechanical pencils available 
everywhere, the thickness of the line was controlled by the thickness of the lead. Standards 
available included 0.03 mm, 0.05 mm, 0.07 mm, 0.09 mm, and so on, and were placed in 
pencils sized to match. Such pencils made for drafting tended to be much more precise and 
well crafted than those available at the local store and had price tags to match. Leads of all 
sizes were available in different hardnesses. Again, harder leads worked better for thinner 
lines and softer leads for thicker lines. Combinations, though, gave the drafter an almost 
infinite variety. Twirling the pencil was still necessary to keep an even line.

I often used ink drafting pens in addition to pencils. With ink, line weight was mainly a function 
of the thickness of the line. Pens came in different thicknesses just like mechanical pencils 
mentioned earlier, and the ink laid out from the pen—after some practice—reflected that 
thickness.

One advantage to using pens was that ink did not erase easily. Therefore, we could do all the 
preliminary work with graphite without having to pay attention to lineweight or crisp stops to 
lines. Once the object was “finished,” we could neatly ink it with proper line weight. The 
rough-in of graphite could be erased, leaving only the ink. On the other hand, one disadvan-
tage to using pens was that ink did not erase easily…

The lighting instruments and their hanging positions should have prime focus, so the set and 
so forth might be drawn in lighter-weight lines. We copied up the architecture, and then we 
redrew the lights themselves with the relevant information. For example, while roughing in the 
plot, noting the purpose of each light is very convenient when shuffling lights around. Having 
the purpose of each light on the final plot is not useful information, so we would not trace that 
up. On the rough plot, I might have quickly noted channel designations, while on the final plot I 
always put them inside a circle connected to each light. Although I drew lighting positions as a 
continuous line on the rough plot, in the final version I drew them “broken” by instruments that 
were also on that position. Notes about trim heights were added, having been decided by 
working out sightlines and angles from the section drawing. Depending on the size of the 
drafting board, that may have meant dislodging the plot-in-process to tape down and draw the 
section. After I finish a light plot and add the titleblock, I sent it off for distribution.

Distribution of drawings was mainly done via “bluelining” an original drawn on vellum. The 
original was fed through a diazo blueline machine with a piece of light-sensitive paper under it. 
The ultraviolet lamp in the machine would cast the shadow of the original on the blueline 
paper. The original exited the machine, while the paper then revolved through an ammonia-
based developing process. Anything dark on the original came through as blue on the finished 
print. Subtle variations and shades translated; but not always quite as subtly as the original 
pencil.

If I needed ten copies of the drawings, I had to manually run the original with a piece of 
blueline paper through the blueline machine ten times. Recently I did a scenic design where 
the set of drawings had 24 sheets. In Ye Olde Days, that meant 240 trips to the blueline 
machine.
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Luckily, most light plots are not so many sheets. The plot, printed, is ready to be distributed to 
the master electrician and anyone else who needs it.

But wait: There is still the paperwork to finish. Information about each and every light is noted 
—by hand in Ye Olde Days on blank forms drawn and reproduced for just such purposes. 
Photocopy those for all involved if there was a photocopy machine available. Hope that there 
are no changes “on the fly,” which necessitate changing multiple sheets of paper—by hand—
for multiple people. John McKernon, author of Lightwright®, tells the story of watching all of his 
tour mates go off to the beach while he remained in the hotel updating the plot and paper-
work…again.

It all was a rather time- and thought-consuming process. And it was not always fun.

I was in graduate school in the mid-1980s when a touring dance company came through the 
Performing Arts Center. I remember vividly a discussion with the Production Manager, who 
was traveling with one of the very first PCs. He could save and update his paperwork as 
quickly as he could type, and then print out new versions right then and there. The implica-
tions were obvious, and it was not long after that designers also began working on preparing 
and presenting visual information on computers. Fast-forward many years, and we now do 
what is basically the same process as outlined earlier, but with much less trauma and stress, 
not to mention much less drafting tape.

Still, the way I approach drafting a light plot in Vectorworks is very similar to the way we  
used to approach drafting by hand. Design layers in Vectorworks are our sheets of vellum;  
we are always drawing on a virtual sheet of vellum. At the end of the process, we will “copy 
up” what we want to print to a sheet layer, placing elements there for visual communication.  
Line weight still gives us as much information as always, so it too gets “reproduced” in our 
digital approach. Communication is still the main point of drafting a light plot. 

Vectorworks Basics

Opening a New Document
I’ll assume you have knowledge of your particular computer and operating system (OS). I’ll 
also assume you have installed Vectorworks software on your computer and have a working 
knowledge of “the basics.” I would suggest working through the free Getting Started Guide  
to learn those basics if you don't already know them. Over the last few years, the  
Getting Started Guide for Vectorworks Spotlight has been written by a very active production 
designer with much theatre, broadcast, and event experience, making it quite relative to our 
industry. Start there. 

Most of the references made in this book are Macintosh-based since that is what I use, but 
“click on the Selection tool,” or “in the Modify menu” should be the same regardless. I’ll note 
that there is a Macintosh/Windows dictionary in the Vectorworks manual that lists exact key 
and menu commands cross-referenced for each platform.

I have my preferences set so that no document is opened when I start the Vectorworks 
program. Selecting New from the File menu opens a dialog box asking what to do. Create 
blank document does just that, creating a “virgin” untitled document. Under Use document 
template, choices can be made from files provided with Vectorworks software. In addition, a 
default template can be created and saved to use at any time.The advantage of this is that 
users can set up their own default to look like anything they want; select scale, paper size, 
default layer and class assignments, default symbols, textures, and document preferences, 
and then save that setup as the default. Every time that document is opened, that setup will 
be used. Over the next few pages, I’ll talk about my preferred setup, and then I’ll talk about 
saving the default file.

When I open a new file, I see the layout shown in Figure 2. This will be the starting point to 
creating my default file.

Workspaces
Workspaces define how the menu commands, tools, and palettes are organized as well  
as define the shortcuts, which are keystrokes that evoke particular tools or commands. 
Vectorworks ships with a series of predefined workspaces that can be selected from the 
Tools>Workspaces menu. Exactly which ones are available will depend on which modules  
of Vectorworks are installed. I’ll assume that the Spotlight module is installed, so that is the 
workspace to start with. The image in Figure 2 shows the Spotlight workspace.

Vectorworks does allow users to customize the tools, commands, and menus to best suit 
individual working habits and to add additional tools or commands to the workspace. I, for 
example, move often from my laptop by itself to my laptop with an additional monitor and 
therefore have two main workspaces customized and saved. Right now, using Vectorworks 
2012, one of my workspaces is called "g12_1scr," and the other is called "g12_2scr." Both 
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have custom menus, custom tool palettes, 
and saved scripts—the difference between 
them is where the palettes are located on the 
screen. When using two screens, I keep 
important palettes open and visible on the 
right monitor while the drawing area and 
basic tools fill the space on the left monitor. 
That layout is saved as "g12_2scr." When I 
am on the road using just the laptop, I switch 
to "g12_1scr," where the palettes are 
collapsed up on top of the Drawing Window 
bar. On the Macintosh, palettes cannot dock 
into the drawing window as in the PC world; 
each remains a separate floating window. But 
they can be collapsed and positioned to be 
as out of the way as possible.

Palettes
Tools used in Vectorworks are organized in 
palettes. The basic 2D tools are in the Basic 
Tool palette. Other tools are arranged under 
tabs in the Tool Set palette. By clicking on the 
tab, tools in that category are displayed.

All of the tool palettes are “tear-offs” in that by 
clicking on the tab bar of the palette, one can 
drag the tools anywhere on the screen so that 
they are not just in the Tool Set palette. 
Moving a Tool palette closer to where the 
actual work is being done saves a lot of 
mousing back and forth. Using shortcuts will 
also save mousing—a keystroke can select a 
tool or execute a menu command. Learning 
the shortcut keys is a very good way to save 
time and energy while drafting. The key combination can be seen in the pop-up tool tips. 

On the bottom of palettes is a drop-down menu that lets me specify whether tools are 
displayed as colored icons, by name, or by both icon and name.

Palettes can be made visible or invisible via key commands or via the Palettes menu. On  
the Macintosh, they can be collapsed by double-clicking in the title bar. In Windows, the 
palettes can be free-floating windows, docked into the main Vectorworks window or hidden 
using the Auto Hide feature.

Palettes can be manually reorganized to fit in any workflow. In addition to the Basic and  
Tool Set palettes, always on the left of my main screen, the palettes I use most often are the 
Navigation palette, the Resource Browser, the Attributes palette, and the Object Info palette 
(referred to as the OIP). I keep them open always, collapsed at the top of the screen when 
working with one screen, or open on the second screen to the right of the Drawing window 
when using two screens. Vectorworks will remember the last location of all palettes and  
put them there when reopened. That is the first step in defining how best to work with 
Vectorworks. The second step is to customize the palettes and menus. 

Figure 2
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Customizing Workspaces
The custom scripts and tools that I use regularly have been added to an individualized tool 
palette called “greggs” and to a menu called “g12_2scr” (on my two-screen workspace), 
named so I know at a glance what workspace is active. In addition, I’ve gathered menu 
commands relating to Spotlight into one menu. Prior to 2011, Vectorworks shipped with these 
menu commands organized by function in many other menus.

In Vectorworks 2011 and 2012, the Spotlight workspace already has all of the Spotlight 
commands in a separate menu. I’ll still want to move some other menu commands around as 
well as add some custom scripts. 

Scripts can be written by anybody and included in menus or as custom tools. Vectorworks 
includes a scripting language that can accomplish many things. Not a coding guru? Many 
repetitive commands can be “memorized” and saved as a simple script to be used again and 
again. The Custom Modification… and Custom Selection tools include this option in the 
dialog box itself.

There are also freeware and shareware commands and tools readily available from other 
users. To find many of them, start with the community page at the Nemetschek website (www.
nemetschek.net/community/index.php). There are several theatre lighting-specific scripts and 
tools available there and elsewhere. AutoPlot, for example, is just such a set of scripts. It is 
available via www.autoplotvw.com. I never leave home without it. I’ve mentioned the video 
screen tool introduced in Vectorworks Spotlight 2010. It originated as a third-party tool set, 
and is still available for earlier versions of Vectorworks. The same author has several other 
tools available; visit Landru Design at www.landrudesign.com. 

While at the Nemetschek community page, also visit the Mailing Lists link, where there is  
a link to the Vectorworks Theatre Mailing List. Here you will find discussion of Vectorworks 
as used in theatre. Many questions are asked and answered here, including scripting 
theatre-specific macros. A member of that list, working in a nontraditional space, asked about 
numbering instruments in a clockwise fashion. Sam Jones, author of the AutoPlot macros,  
had a script written and posted within a day or so of the request. There is a wealth of 
information here! 

I’ve included information about several third-party tools, symbols, and scripts at the end of this 
book. I use them all—some on every plot, and some as needed depending on the complexity 
of the project.

Once acquired or made and saved, any of these scripts and tools can be added to a custom 
workspace. I’ll also rearrange the existing commands and tools to best suit my workflow. To do 
so in Vectorworks, I select Tool>Workspaces>Workspace Editor.

Initially, I’ll work on a copy of the existing workspace, which, as I suggested before, should be 
the Spotlight workspace. I’ll choose to Edit a copy of the current workspace.

I’ll give the workspace a new name. My workspace name tells me which version of 
Vectorworks I made it for and on how many screens.

The workspace editor opens, first showing the menus Editor tab. To create a new menu, drag 
New Menu from the left of the box to the list of menus on the right. Select the new menu and 
rename it as desired. In Figure 3, I’ve named a new menu "gah1scr." Then I can click and 
drag available commands from the left panel to the right under a new menu or an existing 
menu. These do include existing Vectorworks commands as well as third-party commands, 
and the workspace editor now shows all of the new menu commands added in the last three 
versions of Vectorworks.

I can also edit existing menus. The Spotlight menu, as shipped, contains architectural and 
machine design commands. I find little use for the machine design commands, so I delete 
them from my workspace. The one or two I do use, I’ll put into different menus. Likewise, I'll 
move most of the Architectural commands out of the Spotlight menu into other menus. To 

Figure 3
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